DMC FY 2016/17
Annual Resource Planning Process and Financial Plan

Lawson Budgeting and Planning (LBP) Guide

Finance Division
Table of Contents

3 Sections
4 Login
5 Preparing Plan View for 1617 Budget Datasets
6 Introduction
7 Lawson vs. State Terminology
8 LBP Navigation Overview
9 Plan View
10 Financial Tab
11 Accounts View
12 Posting Accounts
13 Accounting Units (“AU’s”)
14 Workforce Tab
15 Workforce Detail Account Lines
16 Additional Hospital Funding in State AU’s
17 Using the Navigation Path
18 Downstate Budget Process
19 Review AU’s
20 View Preloaded Budget & Target Amounts
21 View PS Summary Information
22 Salary Projection for FY 16/17
23 Review Current Positions in the AU
24 Workforce FTE Column
25 Modify Existing Employee Record
26 To Change Employee Pay Rate
27 Modify Workforce Budget Employee Detail
28 To Designate Employee Salary Distribution to Different AU/Add a New Position
29 New Funded Position Requests & Other Adjustments
30 Financial Tab – OTPS
31 Adding & Editing Account Detail Lines
32 Adding & Editing Account Detail Lines Continued
33 Remove Budget Allocations from -99 Sub-AU’s
34 Copying Data to Excel
35 Establishing IFR Budgets
36 FY 16/17 Revenue Dataset
37 IFR Revenue Projection-Balance of Current Year & Next Fiscal Year
38 IFR Revenue Projection-Current Fiscal Year 14/15
39 IFR Revenue Projection-Next Fiscal Year 16/17
40 Adding Editing Detail Lines (for Revenue Items)
41 Total Projected Net Revenue = Maximum IFR Target
42 IFR Expense Budget Request-Allocations
43 Budget Submittal
44 Reports
45 Selecting Report Parameters
46 Exporting Report
47 Training Examples
48 Exercise 1-Change Pay Rate/FTE
49 Exercise 2-Add New/Missing/Replacement Positions
50 Exercise 3-Add Detail OTPS Line
Sections

- Login………………………………………….. Pg. 4
- Introduction………………………………… Pg. 6
- Lawson vs. State Terminology…………….. Pg. 7
- Navigation…………………………………….. Pg. 8
- Downstate Budget Process………………….. Pg. 17
Login

Login Link can be found on Downstate Web Page:
Click Administration > Finance Division > Links > Downstate Medical Center Links >
Lawson Budget & Planning System-Production database (for actual budget input)
OR
Lawson Budget & Planning System-Test database (for training/practice only. Note: Data entered in this
database cannot be transferred to the production system)

Enter your user name and password (same as PC log-in).

- **Budgeting Help:** During the budgeting process if you have questions or need assistance, please send an e-mail to BudgetHelp@downstate.edu
- **Remote Access:** To access LBP remotely, you must be connected to your DMC desktop using VPN access. Please email the IT help desk: helpdesk@downstate.edu to request VPN access.
- **MAC Users** – Contact IT Helpdesk helpdesk@downstate.edu for password.
- **All Users:** LBP works best with Internet Explorer (version 7 or higher).
In order to see the proper datasets for this year’s budget you must do the following:

1. Click on PLAN button
2. Click Open Plan View
3. Click on Restore Default Plan View
4. Click OK
Introduction

DMC will be using Lawson Budgeting and Planning (LBP) for the 2016/17 Budget Cycle.

The three main budgeting steps are:

1. Review Personal Service.
2. Review Contractual OTPS Obligations.
3. Enter other OTPS Requests.
Lawson vs. State Terminology

**Account vs. Accounting Unit (AU)**

“Accounting Unit” or “AU” in Lawson = State “Account”.

“Account” in Lawson = State “Object Code”.

- **Summary Accounting Unit (AU)** - Alpha-numeric names representing a **total** of a group of AU’s.
  
  Examples:
  
  - VP1 - VP – ADMINISTRATION
  - AA - Affirmative Action
  - 7H-CEO - Hospital CEO

  The AU hierarchy flow is as follows:

  VP Area -> Division -> Fund within division -> Posting level AU.

  Fund roll-up AU’s- First 2 positions represents the fund as follows:

  - 0R - General IFR
  - 3R - State Purpose
  - 4R - Dormitory

  - 5R - Hospital IFR
  - 7H - Hospital

- **Posting Accounting Unit (AU)**
  
  - 8 digit number representing the AU level where budget data can be edited.
  - Lowest level in the AU hierarchy.
  - Examples: “90010202 – PUBLIC SAFETY”, “37136000 – SECURITY”

- **Summary Account** - Non-numeric names representing a **total** of a group of accounts.
  
  Examples:
  
  - PS - Personal Service
  - CONTSvc - Contractual Services
  - LIB – Library Acquisitions
  - SUP - Supplies

- **Posting Account** - 4 digit number representing the account level where budget data can be edited.
  
  Examples:
  
  - 5003-Conference/Training Services
  - 5006-Memberships
LBP Navigation Overview

Understanding the LBP Screen Components:

• There are 4 basic LBP screen components:

  – Plan View ................................................................. Pg. 9
  – Financial Tab ............................................................. Pg. 10
  – Workforce Tab .......................................................... Pg. 14
  – Navigation Path Breadcrumbs ...................................... Pg. 16
Plan View

- Once you log in, you will see the Plan View for your department.
  - The Plan View provides rows of expenditure accounts and columns (known in LBP as datasets) with information that will assist you in preparing your budget.
  - You will only see AU’s you are affiliated with.

- The following datasets were preloaded in the system:
  - 14/15 Actuals- Total Expenditures for FY 14/15
  - 15/16 Allocated – Original 15/16 budget allocation (for reference only)
  - 16/17 Targets - Total allocation by division & fund. 16/17 Budget cannot exceed Target
    (Note: Targets can only be viewed in Financial Tab; for reference only)
  - 16/17 Budget - Projected budget (for data entry)
  - 16/17 Revenue – IFR au’s only - Cash Balance data as of 2/28/2016
  - Note: To access prior year datasets: Click Plan, select the dataset from the drop down menu & add to Plan View.

For Reference Only

For data entry
Financial Tab

• The Financial tab is where you will enter:
  – OTPS (Other Than Personal Service) budget requests.
  – PS (Personal Service) lump sum amounts at a non-employee level.
    • Note: Detailed calculations for employee related costs are computed in the Workforce tab. The resulting summary amounts from Workforce are reflected in the Financial Tab at the account level.

• The screen below shows the Financial tab is active. Note the light blue color of the active tab.

![Financial Tab Screen](image-url)
Accounts View

- Shows the roll-up of expenditure categories. Drill down to lower level accounts by clicking the (+) symbol on left of summary accounts.
- When viewing data at a summary AU level, the account view shows total data values for that summary AU. You cannot edit the data at these levels.
- When viewing data at the posting AU level you can edit and update your budget.
Posting Accounts

- View and enter data at the posting account level.

- While at a posting AU level, drill down from a summary account to posting account.

- Alternately select the **Posting Accounts** view from the drop down box.
  - It will list all of the posting accounts for that AU.
Accounting Units / AU’s

- Budgets are always updated at the posting AU level (yellow boxes indicate data entry field).
- Expand or drill down into the AU to the posting AU (lowest level).
- Click on the plus “+” sign to the left of each summary AU to expand to the next level. You are at the posting level when there are no more “+” signs to expand.
- **Note:** If you are assigned only to posting level AU’s, you will not see the AU summary hierarchy.

**Note:** When you click on a posting level AU, the view automatically returns to Accounts for that AU.
Workforce Tab

- For entering new and changing current PS salary component $ amounts.
- Lists all positions and employees in your Posting AU.
- The **16/17 Budget** dataset has been pre-populated with projected PS budgets for each AU. These preloaded numbers can be edited.

Click on the ID number to drill down to employee details.

The vertical Green navigation arrows can be used to display more personnel in the **Workforce Plan view**.
Workforce Detail Account Lines

- Workforce detail lines appear when you click on a Workforce budget ID # (equivalent to “line #”)
- Each detail line represents a unique pay code. Numbers are entered into the yellow input fields to create a workforce budget.
- Budget FTE determines the distribution percent to currently displayed AU for a position.

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
<th>Job/Position</th>
<th>Employee</th>
<th>Pay Rate</th>
<th>2014 14/15-Actuals</th>
<th>2015 15/16-Allocated</th>
<th>2015 15/16-Targets</th>
<th>2016 16/17-Budget FTE</th>
<th>2016 16/17-Budget Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20755</td>
<td>PROFESSOR (adj)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0100-ADMINISTRATIVE NR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0400-INSTRUCTIONAL NR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0500-SUPPORTING ACADEMIC NR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0600-PROFESSIONAL-OTHER NR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1500-MAINT SECURITY TR NR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1700-CLASSIFIED-CLERICAL NR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2200-CLASS CLERICAL NR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2699-OTHER-GRADUATE STUDENT NL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2699-OTHER-SEGMENT FB EX NL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2750-RETIREES BASE PAY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1905-GEOPHYSIC RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2052-ALSO RECEIVES RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1922-SHIFT DIFFERENTIAL RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1925-Salary Raise (contract) RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1908-INCONVENIENCE PAY RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1909-INTER-IN RESIDENCE RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2055-GEOPHYSIC RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2061-LOCATION RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1911-LOCATION RU</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3,024.00</td>
<td></td>
</tr>
</tbody>
</table>

Click to see AU distribution and employee details
Click to change Pay Rate/Salary
Enter FTE detail in yellow highlighted fields
Enter detailed fixed amounts for items such as: Location Pay, Also Receives
Additional Hospital Funding in State AU’s

- Hospital is expected to receive additional allocation in FY16/17 appropriated to State Accounting Unit 860089.
- To utilize this allocation, various Shared Service Positions, previously charged to Hospital AU’s, were temporarily transferred to AU 860089-XX* (-XX is the 2 digit sub-account for the department).
- Budget Allocation has been projected for these positions in the original Hospital Shared Service AU, instead of 860089-XX. No action is necessary if this is the correct original AU for that position.
- The position description detail indicates if the position is charged to 860089 in FY 15/16. (Click position title in description column of the Workforce Tab to get the Modify Workforce Budget window)
Using the Navigation Path

- The **navigation path**, also referred to as **breadcrumbs**, appears at the top of the screen.
  - Path used to get to where you currently are in the plan view.

- **To create a breadcrumb:**
  1. Open an AU from Plan -> Open Accounting Unit,
     - *(Note: if AU's are grayed out, it means that you have not been assigned access to view these AU's.)*
  2. Select or type in an AU to be your starting point and click **OK**.
  3. The name of the AU appears in the navigation path.
  4. In the **Accounting Units** view, click on each AU level from the top summary to the posting level, to see the breadcrumb path at the top of the screen.
  5. Each time you drill down into a summary AU, summary account or posting account, the navigation path is updated.

**NOTE:** Expanding the AU levels by clicking on the plus sign to the left of each AU does not update the navigation path.
Downstate Budget Process

• Review AU’s

• PS Information
  – View PS Summary Information
  – Review current positions and employee’s record
  – Review/adjust employee salary AU distribution
  – Add new Funded Position Requests & Other Adjustments

• OTPS Details and PS (non workforce)
  – Enter a Budget Request (OTPS and PS non-workforce)
  – Enter budget detail lines
Review AU’s

• In the **Financial Tab Plan View**, select **Accounting Units** from the drop-down box.

• You will see the AUs that you have been assigned to.
  – **Note:** You may see AU’s on the screen that are grayed out. You have not been assigned to these AU’s. They appear so you can see where your AU’s roll up in the organization hierarchy.

Summary roll-up AUs have been created. **The AU flow is as follows:**
  VP Area -> Division -> Fund within division -> Posting level AU.

• Contact [BudgetHelp@downstate.edu](mailto:BudgetHelp@downstate.edu) if AU’s are missing or don’t belong to you.
View Preloaded Budget and Target Amounts

- Review the preloaded 16/17 Projected Budget amounts
- In Financial Tab - View Targets data at Summary Level AU’s for Fund Within Division
  - Target amounts appear only if you are assigned to all of the AU’s for a fund within a division
  - Targets appear for Fund/Division for State (3R), Hospital (7H) and Dorm (4R) Funds.
- **Note**: Targets are subject to change
View PS Summary Information

- Click on the **Financial** tab.
- Select **Accounts** from the **Accounts/Accounting Unit** drop menu field.
- View salary information by expense type (accounts/object code)
- Drill down by clicking on the plus signs until lowest detail account is displayed.

![PS Summary Accounts]

![PS Detail Accounts]
Salary Projection for FY 16/17

Workforce Salary Projection for 16/17 is based on employees on Payroll as of PR 23 (2/24/2016 paycheck). See tables below for categories included/excluded in the projection:

**Contractual Salary Increases included in Salary Projection**

**UUP**
1% Discretionary 7/1/16 – Est. $885 one-time, not on base-budgeted at AU level, object code 1925

**MC**
2% of base – effective 4/1/16 - add to base (full FY 16/17)
2% of base – effective 4/1/17 - add to base (one qtr. FY 16/17)

Other Unions - Contracts under negotiation.

---

**Salary Projection for FY 16/17 Does NOT Include:**

- Overtime 1948
- Holiday Pay 1947
- Vacation Payoff 1918
- Overtime meals 1985
- Also Receives (Temp Svc) 2052
- Geographic (Temp Svc) 2055
- Location (Temp Svc) 2061
- Supporting Academic** 2100
- Adjunct** 2400
- Teaching Assistants 2483
- Extra Service 2499
- Student Assistants 2600
- Deficit Reduction Leave Payback *** 0000

---

**2100 / 2400 are projected with $1 as a placeholder for hourly employees, and should be adjusted as necessary.**

---

***Deficit Reduction Leave (DRL) payback – No funding is included in budget. No action is required in 16/17 budget. SMRT will show expenses coded for DRL which will be transferred to another fund at year end. During the Fiscal Year, when reviewing AU balances in SMRT, accumulated expenses for DRL should be manually removed from the expenditure column, in order to determine the adjusted AU balance.
Review Current Positions in the AU

- Click on the **Workforce Tab**
- Open **Plan -> Accounting Unit**. Select a posting AU.
  - Scrutinize all positions to determine if salary / distribution is correct.
  - Determine if positions are needed or should be eliminated if possible.

- Select an employee record to work on by clicking on a Workforce budget **ID**.
  - Review the employee’s record.
  - Determine if the position is correctly charged to the AU and required for FY 16/17.
  - **If this Position /Line does not belong in this AU:**
    - Contact Human Resources and Financial Management Department to determine course of action for correction in SUNY System. If necessary, submit change in payroll distribution to Human Resources, with a copy to Financial Management.
    - For Budget Purposes, change budgeted amounts and FTE to zero

- **Note:** The system has been pre-loaded with a projected budget for Personal Service, based on Payroll PR23 (2/24/2016).

### Table Example

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
<th>Job/Position</th>
<th>Employee</th>
<th>Pay Note</th>
<th>2014</th>
<th>2015</th>
<th>2016</th>
<th>2016-Budget FTE</th>
<th>2016-Budget Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>20042</td>
<td>MOTOR VEH O</td>
<td>20042</td>
<td>Dekhtyar, A.</td>
<td></td>
<td>2.10</td>
<td>0.35</td>
<td>0.35</td>
<td>0.35</td>
<td>0.35</td>
</tr>
<tr>
<td>33672</td>
<td>MOTOR VEH O</td>
<td>33672</td>
<td>Hercules, F.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38199</td>
<td>MOTOR VEH O</td>
<td>38199</td>
<td>Inness, Hen.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20283</td>
<td>MOTOR VEH O</td>
<td>20283</td>
<td>Lamblin, Se.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38086</td>
<td>MOTOR VEH O</td>
<td>38086</td>
<td>Morgan, Lei.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33993</td>
<td>STAFF ASSOC</td>
<td>33993</td>
<td>Powell, Rob.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Workforce FTE Column

**Note:** The first time you log into LBP, the FTE column may not appear in your Workforce view.

To see the FTE detail column:

- Click on the **View** dropdown box and select **Display WF Components**
- Click on the box to the left of **FTE** and a check mark will appear
- Click **OK**
Modify Existing Employee Record

- If salary rate is incorrect or not properly distributed to AU’s and salary components.
  - Change pay rate (also use for changing to part-time & vice versa)
  - Change number in FTE field to desired percentage for that AU.
  - Change Unit amounts for non base salary pay codes, i.e.; Location Pay, also Receives.
  - Change end date of position (i.e.; retirement or resignation) using the **Modify Workforce Budget** screen.

- To delete an employee record.
  - If a position is no longer needed, change the Pay Rate, FTE and unit amounts for that employee to zero. Do not delete.
To Change Employee Pay Rate

• From the Workforce tab, click on the employee **Pay Rate** field.

• The **Pay Rate Assignment** screen will open.
• Click the pencil under the word **edit** and enter the pay rate (base annual salary).
• Click **OK**
Modify Workforce Budget Employee Detail

While viewing **Workforce Budget ID** detail, click in the **Description** field to drill down to the **Modify Workforce Budget** screen.

- **Property** tab – Can edit the following fields:
  - **Description** - Position title.
  - **Comment** -
    - If employee is allocated between multiple AU’s, enter the % breakdown by AU for that employee.
    - If modifying an employee record, indicate what was changed, example “changed FTE from .5 to zero”
  - **Start Date** - Expected start date.
  - **End Date** - Blank or expected end date. *(Note: If employee is leaving during the budget year, and the position will be refilled, a new employee record can be created for the balance of the year)*

**Employee** tab *(Reference only )*

- Shows detailed employee data including: Job and position codes, hire date

**Budget Distribution** tab

- **NOT** used by Downstate
To Designate Employee Salary Distribution to Different AU / Add a New Position

- From the Financial Tab, select the posting AU to work on.
- Select the Workforce tab and click on the Add Budget button. The Add Workforce Budget input screen will appear.
- Enter data into Add Workforce Budget fields
- Click OK

Add Workforce Budget fields (A red asterisk = required field):
- **ID** - Same as the DMC Line number.
  (for a new line number use the format: “NEW-sequence # - Posting AU”. Example: “NEW#1-84074901”)
- **Description** - Position title. If existing position, can put in employee name.
- **Job/Position Code** - Click the Find button. Select Position Code. If existing position, same as line number. For additions, select from “Generic codes”.
- **Comment**: (1) If employee is allocated between multiple AU’s, enter the % breakdown by AU for that employee. (2) If modifying an employee record, indicate what was changed, example “changed FTE from .5 to zero”
- **Start Date** - Expected start date.
- **End Date** – Leave blank or enter or expected end date.
- **Pay Rate** - Total annual base salary.
  (Note: For part time employees use actual salary paid, not annualized rate)
New Funded Position Requests & Other Adjustments

• Add existing positions that are missing from the accounting unit.
• Add positions that are approved/funded but not yet filled. Sufficient funding must be available within the target for these positions.
• Request programmatic approval for a new funded position. Sufficient funding must be available within the target for these positions.

There are generic position codes to represent the type of position you might need to add to an accounting unit.

• Generic Position Types:
  – PS Regular:
    • 0-MISSING Existing missing from list
    • 0-NEW-FUNDED New position within budget
    • 0-VACANT Vacant approved funded
  – PS Temp Employees:
    • 0-MISSING-TEMP Temp - Existing missing from list
    • 0-NEW-FUNDED-TEMP Temp - New position within budget
    • 0-VACANT-TEMP Temp - Vacant approved funded
Financial Tab

- To View OTPS (Other than Personal Service) Summary Information
  - Click Financial tab.
  - In the Financial view click on a summary account to review
  - Summary Account “OTPS – Totals” is the total of all OTPS accounts
  - Drill down to see details

- Entering a Budget (OTPS and PS lump sum adjustments)
  - After selecting your posting AU, the screen will show Accounts in the Financial tab view. Budgets may only be entered at the posting AU level.
  - Edit or add amounts to 16/17-Budget. Input desired dollar amounts in the fields highlighted in yellow.
  - PS lump sum adjustments can be made by changing the amount in the yellow box, or at the detail lines level, but adjustments made in the Financial Tab will not show up in the Workforce Tab.
Adding and Editing Account Detail Lines

• Detail lines are used to breakdown / describe the amounts entered in a posting account. For example, you may want to list contracts, suppliers or equipment type.
  – **Note:** The 16/17 Budgets have been preloaded with contract detail based on the prior year LBP data. Edit as necessary.

• To add and edit detail account line data:
  – Click on a posting account.
  – Click the **Edit** dropdown box and select **Detail Lines**.
  – The **Change Line Items** window will open
Adding and Editing Account Detail Lines (continued)

• From the Change Line Items window: Click the Add Line box and type a description in the Line Name Field.

  Note: For contracts, the Budget Office recommends the following description format: “Contract#-Contractor-Contract Description”

• Add a line for each budgeted item and click Apply to move the item to the left box. (You will not be adding dollar amounts on this screen.)

• Hit OK and you will now see the screen to enter line item amounts. Enter amounts in the yellow fields.

• Hit the Save button in the upper right hand corner of the screen to save changes.

  Note: The Adjustment line will show the difference between the total of the detail lines entered and the amount that appears in the Financial tab view for that posting account.
Remove Budget Allocations from -99 Sub-AU’s

*Allocations are not allowed in an AU with a -99 sub-account.*

- If you are responsible for any Sub-AU ending with digits “99”:
  - Make a note of the line number (ID) and pay rates
  - Change distribution FTE to 0 (budgeted amounts for base salary will automatically be zeroed out).
  - Change all other pay rates to zero by clicking on the number / save.
  - Add the position to the correct AU
  - To change distribution of salary to correct AU, submit paperwork to [Human Resources Department, and a copy to Financial Management Department.](#)
  - Check to ensure all -99 sub AU’s have $0 budget before submittal.
Copying Data to Excel

You can copy the contents of your plan view as it is displayed, to Excel.

Quick and easy way to copy contents of the plan view for review and to produce a hard copy of the budget.

To Copy Data to Excel:

1. While in financial tab, choose Plan > Copy to Excel
2. The contents are copied to the clipboard
3. Click OK
4. Open a file in Excel and paste.
5. Format worksheet as desired.
Establishing IFR Budgets

• For FY 16/17, projected revenue must be posted to LBP, in addition to projected expense budgets.
• Revenue data is needed in order to:
  – Manage balances and reserves of the Income Fund Reimbursable (IFR) AU’s.
  – Analyze and resolve deficit balances.
  – Provide new leadership with tools to review & evaluate multi-year programs, in order to enable appropriate decisions in allocating available resources to meet the mission of the institution.
  – Explain spending of prior year balances.
  – Enable Downstate to be more precise in quantifying requests for allocation from SUNY.
• In order to establish a budget allocation for an IFR AU, first the projected net revenue for the balance of the current fiscal year and next fiscal year must be determined.
• Total projected cash available will become the target, or maximum allocation that can be requested for each IFR.
• Projected Revenue is to be posted to the FY 16/17 Revenue Dataset.
FY 16/17 Revenue Dataset

- **IMPORTANT**: In order to input Revenue Projection into the correct fields, the active dataset must be changed to FY 16/17 Revenue.
- Open Plan View Setup
- At bottom portion of the screen, “Active” Column, click the bubble next to FY 16/17 Revenue. Click OK.
- If done correctly, posting entries may now be made to yellow fields in FY 16/17 Revenue Column.
IFR Revenue Projection
Balance of Current Year and Next Fiscal Year

• There are two main components of IFR Cash that will be available for allocation in next fiscal year:
  – Current Fiscal Year – Total of Projected changes between now and end of FY 15/16 (6/30/16)
  – Next Fiscal Year – Total of Projected Net Revenue for FY 16/17 (6/30/17)

• Choose an IFR AU: Open Plan -> Accounting Unit. Select a posting AU Click: Find Next, OK.

• In Accounts View, Expand* Total Revenue to see Current Fiscal Year & Next Fiscal Year Summary level AU’s
  * Click Plus (+) on left of “Total Revenue”
IFR Revenue Projection
Current Fiscal Year -15/16

- From Financial Tab, Accounts view, Expand Current Year (CYR) Summary AU (+), and Expand each Summary AU below CYR to posting level account, to enter Components of Current Fiscal Year 15/16 Projection:
  - Current Cash Balance –
    - Preloaded: Actual Balance as of 2/29/16
  - Projected Additional Revenue through 6/30/16 from following sources (for user input):
    - Contracts (i.e. Affiliation Contracts)
    - Grants (i.e. Research Foundation)
    - Fee Revenue (i.e. Tech Fee)
    - Other
  - Reductions to Revenue (for user input)
    - Expenses Projected to Year End
    - Fringe Benefits (55.88% for most IFR’s*)
    - Maintenance (8.7%) and/or Admin Overhead (5.6%)-if applicable
    - Note: Positive Figures entered into Reductions category will appear as negative numbers on Summary AU line, for calculation to reduce cash available.

* for exceptions, contact Budget Office
IFR Revenue Projection
Next Fiscal Year – 16/17

- From Financial Tab, Accounts view, Expand Projected Next Year (NYR) Summary AU (+), and Expand each Summary AU below NYR to posting level account, to enter Components of Next Fiscal Year 16/17 Projection:
  - Projected Revenue for FY 16/17 (7/1/15-6/30/16) from the following sources (for user input):
    - Contracts (i.e. Affiliation Contracts)
    - Grants (i.e. Research Foundation)
    - Fee Revenue (i.e. Tech Fee)
    - Other
  - Reductions to Revenue (for user input)
    - Fringe Benefits (est. 55.88% for most IFR’s)
    - Maintenance (8.7%) and/or Admin Overhead (5.6%)-if applicable
    - Note: Positive Figures entered into Reductions category will appear as negative numbers on Summary AU line, for calculation to reduce cash available.

* for exceptions, contact Budget Office
Adding/Editing Detail Lines

- Detail lines are used to breakdown / describe the amounts entered in a posting account.
- User is **required** to list revenue for individual contracts, Research Foundation grants, fringe benefits for each employee, number of residents, justification for spending prior year balances, etc.

To add detail account line data:
- Click on a posting account.
- Click the **Edit** dropdown box and select **Detail Lines**.
- The **Change Line Items** window will open
- Click Add Line, Enter description, Click Apply, OK
- Line will appear on the screen. Input dollar amount in 16/17 Revenue column.

To edit detail account line data:
- Click the **Edit** dropdown box and select **Detail Lines**.
- Click on the line item that you want to edit.
- Adjust description, Click Apply, OK (or Delete)
- Modified line will appear on the screen
Total Projected Net Revenue = Maximum IFR Target

- Once you complete the revenue projection for the IFR, total cash available for budget request will be shown in Total Revenue Summary AU. This amount will be the maximum target for the FY 16/17 allocation request (SUNY’s authority to spend cash). Requested amount can be equal to or less than targeted amount.
- Next, input Allocation Request (Projected Expense Budget).

![Financial Table]

<table>
<thead>
<tr>
<th>Accounts</th>
<th>2015 15/16-Budget</th>
<th>2015 15/16-Revenues</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOT-REV-Tot Net Revenues (Maximum Request)</td>
<td>0</td>
<td>459,900</td>
</tr>
<tr>
<td>CYR-CURRNT YEAR</td>
<td>0</td>
<td>300,000</td>
</tr>
<tr>
<td>NYR-PRJCTD NEXT YEAR</td>
<td>0</td>
<td>159,900</td>
</tr>
<tr>
<td>TOT-EXP-Tot Expenses</td>
<td>261,144</td>
<td>0</td>
</tr>
</tbody>
</table>

**Financial Table**: The table demonstrates the relationship between Total Net Revenues and Total Expenses, showing how they relate to the annual budget allocations for SUNY.
IFR Expense Budget Request-Allocations

- **IMPORTANT**: In order to input Expense Budget Request into the correct fields, the active dataset must be changed back to FY 16/17 Budget

- Click: Plan, Open Plan View. Plan View Setup screen will appear

- At bottom portion of the screen, “Active” Column, click the bubble next to FY 16/17 Budget, Click OK

- If done correctly, posting entries may now be made to yellow fields in FY 16/17 Budget Column

- Enter Budget Allocation Request in Posting Expense Accounts, following same procedure for all other AU’s

- Compare Total Expense Summary AU with Total Revenue Summary AU. Requested allocation must not exceed Target)
BUDGET SUBMITTAL

• When you have completed your budget input:
  – Check that all 16/17 budget figures match targets by fund (if you have access to view targets)
  – View & Save “Reports”
  – Notify the next budget reviewer/approver for your area.
    • If you are unsure who reviews the budget next, please send an email to BudgetHelp@downstate.edu

*** Completed preliminary budgets must be submitted to Budget Administration by May 20, 2016***
Reports

- Click on Report to bring up the Lawson Budgeting and Planning Tab.

Available reports to view are listed:

- Account/Unit Reports
- Employee Reports
- Sub Division Reports
- Contract Reports

Click the dropdown arrow on each header to view additional report categories.

*Note - if Reports don’t appear on the screen, send an email to BudgetHelp@downstate.edu
Selecting Report Parameters

In the Lawson Report Viewer, select parameters for your report.

- From the **Enter Dataset** menu, click the dropdown arrow and select the first dataset parameter for the report.
- From the **Enter Dataset 2** menu, click the dropdown arrow and select the second dataset parameter for the report.
- Select a **Report Target**.
Exporting Report

- Click the Export icon in the report toolbar.
- From the Export window, enter report page numbers and click the Export button.
- From the dropdown menu, select file format for the report and click the Export button.
Training Examples

• For training / practice purposes, you may log in to the **Test** Database and try the following exercises.

• Please note that any changes made in Test Database will not be transferred to the Production Database, so please ensure that you are logged in to Production Database when you are ready to enter the actual budget.
Exercise 1

Modify Workforce Budget

1. Open an employee detail record
2. Change Pay Rate to $120,000
3. Change Base/Shift Pay FTE to .2
4. Change LOCATION RU (Location pay) Units to $604.80
5. Open Modify Workforce Budget screen and type in a comment reflecting the changes that you made.
6. Save changes
Exercise 2
Add New Funded Position

1. Open **Add Workforce Budget** screen
2. Enter ID: “NEW-[AU#]-1”
3. Enter position description
4. Select Position code: “0-NEW-FUNDED”
5. Enter AU distribution comment
6. Enter start date of 7/1/16
7. Add annual base salary pay rate of $100,000 and hit OK
8. From Workforce tab, click on the new position # just added
9. Change FTE to .5 for pay code line “0500-SUPPORTING ACADEMIC NR”. Zero out any other FTE amounts for base pay
10. Change Location Pay, “1911-LOCATION RU” to $3,043
Exercise 3

Add Detail OTPS Line

1. Open detail line for posting account “5000 – Contracts”
2. Add new line ”C123-Poland Springs-Water cooler rent supp ”
3. Move the new line to appear first
4. Apply Changes
5. Enter $700 for “C123-Poland Springs-Water cooler rent supp and save changes”
6. Click back to the Accounts view.
7. On “5000 – Contracts” line, increase contracts amount by $8,000 and hit Save button.
8. Open “5000 – Contracts” detail line again. The adjustment line should show $8,000.